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2. About this document

2.1. Legend

The following symbols and formats will be used throughout the document.

Important
It gives you important information about the subject.
Please read carefully!

Hint
It gives you a hint or provides additional information about a subject.

Example
Gives you an example of a specific subject.
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3. Introduction

The DS-CAL test board is a calibration device and DSCalibrator is the software used for calibration and
testing of Dewesoft UUT. The calibration system consists of:

● A computer or PC (running DSCalibrator software)
● Multifunction calibrator
● Digital multimeter
● DS-CAL test board
● UUT
● Proper set of cables according to the UUT

In order for a correct operation of your calibration system the procedures described in this manual must
be followed. If you should encounter any problems during the installation and use please feel free to
contact our support team.

Image: Block diagram of the calibration system
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3.1. Calibration system equipment support

Important
Please read this chapter carefully! It contains important information about calibration system
equipment support and usage.

3.1.1. Multifunction calibrator support

Important
Multifunction calibrator MUST be calibrated 1 per year in accredited laboratory in order to
assure correct measurements. Check if the calibration laboratory, who will perform calibration,
is accredited. After calibration check that the calibration laboratory included their accreditation

number on the certificate!

Important
All specifications apply for the temperature and time period indicated. For temperatures
outside of tcal ∆ (tcal is the ambient temperature when the Multifunction calibrator was
calibrated), the temperature coefficient as stated in the General Specifications must be applied.

The specifications also assume the calibrator is zeroed every ˝n¨ days or hours or whenever the
ambient temperature changes. See additional specifications for your device!
If the specifications are not followed, the accuracy can drift out of specifications!

Example
Zero FLUKE 5502E

All specifications apply for the temperature and time period indicated. For temperatures outside of tcal
±5 °C (tcal is the ambient temperature when the 5502E was calibrated), the temperature coefficient as
stated in the General Specifications must be applied.
The specifications also assume the Calibrator is zeroed every seven days or whenever the ambient
temperature changes more than 5 °C. The tightest ohms specifications are maintained with zero
calibration every 12 hours within ±1 °C of use. Also see additional specifications later in this chapter for
information on extended specifications for ac voltage and current.
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Image: Zero Calibration bridge Fluke 5502E

The following multifunction calibrator models are supported:
● Fluke 5502A
● Fluke 5502E
● Fluke 5522A
● Fluke 5700A
● Fluke 5720A
● Fluke 5730A
● Fluke 5540A

Feature FLUKE 55XX series FLUKE 57XX series

Thermocouple calibration

Krypton 8xTH/16xTH/8xTH-HS
IOLite 8xTH/8xTH-HS
DSI-TH-K/T/J/B/C/E

Supported NOT POSSIBLE*

Extended filter tests on Sirius
HS/XHS modules

NOT POSSIBLE** Supported

Current clamp calibration Supported NOT POSSIBLE***

Current /calibration

Krypton 3xSTG/6xSTG/8xLA/1xSTG
IOLite 6xSTG

Supported NOT POSSIBLE****

Krypton-RTD, IOLITEi-8xRTD,
IOLITEi-8xRTD-HS

***Fluke 5500A NOT supported

* Thermocouple output is not available by the multifunction calibrator.
** Extended frequency range for AC voltage is not supported by the multifunction calibrator.
*** Supported AC / DC current output capabilities are too low.
**** Fluke 57xx series uses additional terminal posts for DC current which are not possible to connect
to the DS-CAL test board.
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3.1.2. Digital multimeter support

Important
Digital Multimeter MUST be calibrated 1 per year in accredited laboratory in order to assure
correct measurements. Check if the calibration laboratory, who will perform calibration, is
accredited. After calibration check that the calibration laboratory included their accreditation

number on the certificate!

The following digital multimeter models are supported:
● Keysight 34465A
● Agilent 34410A
● Agilent 34401A
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3.2. Basic principle
The multifunction calibrator is used for generating signals which are measured by the Dewesoft UUT.
The DSCalibrator software (in cooperation with Dewesoft) records these measurements and also makes
adjustments to the calibration factors stored in the UUT. The DS-CAL test board is used for distributing
the signals to and from the UUT and is controlled by the DSCalibrator software over the CAN or USB
interface. The digital multimeter is used for measuring output voltage or current (for example the
excitation voltage)

3.3. Scope of supply

3.3.1. DS-CAL-BOX

Qty Type Usage Picture

1x DS-CAL-BOX DS-CAL test board.

1x DC Power supply 60W 12V
including power cord

Power supply for DS-CAL test
board.

1x USB‑A to USB‑B‑mini cable,
1.8m

Used for connecting DS-CAL
test board to the PC.

1x Installation USB stick Contains the software, drivers,
and manuals.

2x
USB‑to‑serial converter

including RS232 cable, 1m
(D9f-D9f‑1M‑RS232)

Used for connecting the PC,
multifunction calibrator, and

the digital multimeter
together.

1x CAN Y‑cable, 1.2m
(D9F‑2D9F‑1.2m)

Used for connecting the CAN
port(s) between UUT and the

DS-CAL test board.

1x PPS cable, 2m (L1B4M‑BNC‑2m)
Used for a precise PPS time

source signal. Connects to the
DS-CAL test board.
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2x Sync cable, 3m
(L00B4m‑L00B4m‑3m)

Used for connecting the Sync
ports between the UUT and

the DS-CAL test board.

1x
Banana cable, 2m

(CABLE‑GND) with crocodile
clip

Used for connecting GND
between the UUT and the

DS-CAL test board.

12x Safety test lead 4mm, red with
gold‑plated contacts, 1m

4x used for multifunction
calibrator and digital

multimeter connection with
the DS-CAL test board.

11x Safety test lead 4mm, black
with gold‑plated contacts, 1m

3x used for multifunction
calibrator and digital

multimeter connection with
the DS-CAL test board.

8x BNC‑to‑BNC cable, 0.5m Used for connecting BNC UUT
inputs and DS-CAL test board.

8x BNC‑to‑BNC cable, 1.2m
Used for connecting BNC UUT
analog outputs and DS-CAL

test board.

8x MULTI cable, 0.4m
(D15m‑D15m‑0.4m)

Used for connecting MULTI
UUT inputs and DS-CAL test

board.

8x DSUB9 cable, 0.4m
(D9m‑D9m‑0.4m)

Used for connecting all DSUB9
UUT inputs and DS-CAL test

board.

8x Counter cable, 0.4m
(L1B7m‑L1B7m‑0.4m)

Used for connecting UUT
counter inputs and DS-CAL

test board.
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3.4. Optional accessory packages

3.4.1. CHG-CAL-ADAPTER
Accessory package CHG-CAL-ADAPTER is required for calibration of SIRIUS-CHG and SIRIUS-HS-CHG
modules and for DSI-CHG-50 adapters:

Image: CHG-CAL adapter accessory package

3.4.2. KRYPTON-TH-CAL-SET
Accessory package KRYPTON-TH-CAL-SET is required for calibration of Krypton 8xTH / 16xTH,
IOLITEi-8xTH, 8xTH-HS and IOLITEir-8xTH, 8xTH-HS.

Image: TH-CAL-SET
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3.4.3. IOLITE-CAL-SET
Cable bundle for calibrating every IOLITE module.

The set includes:
- 8x BNC-T2B2m
- 8x D15m-L0B6m
- 2x 4xBNC-T2B9m
- 8x T2B9f-D9m
- 2x D37m-4xD9f
- 1x TH-CAL-SET
- 8x D15m-T2B4m
- 2x 4xBNC-T2B12m
- 1x 4xBNC-T2B8m

3.4.4. DSI-CAL-SET
Accessory package DSI-CAL-SET is required for calibration of DSI adapters:

Image: Content of DSI-CAL-SET package
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3.4.5. DSI-5A-CAL-CABLE
Accessory package DSI-5A-CAL-CABLE is required for calibration of DSI-5A adapters:

Image: DSI-5A-CAL-CABLE accessory package

3.4.6. 100nF-CAP-STD
Accessory package 100nF-CAP-STD is required for the calibration of DSI-CHG-DC adapters.

Image: 100nF-CAP-STD accessory package

Important
100nF-CAP-STDmust be ISO calibrated.
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3.4.7. DS-TOOL-CAL-DOCK
The DS-TOOL-CAL-DOCK is a calibration docking station compatible with DEWE-43, SIRIUS, IOLITE and
KRYPTON devices in modular or slice variants.

Image: Calibration docking station DS-TOOL-CAL-DOCK

3.4.8. DS-CAL-BOX-DB
Accessory package DS-CAL-BOX-DB is required for the calibration of the “+-DB” devices (example
SIRIUSi-8xSTG+-DB) which have 8 counters (24 DI on DSUB37m, 8 DO on DSUB24f). Accessory package
include DS-CAL-BOX-DB, D37f-D37f-0.8m-CAL-CABLE and D25m-D25m-0.8m-CAL-CABLE.

Image: DS-CAL-BOX-DB

Hint
First you connect cables D37f-D37f-0.8m-CAL-CABLE and D25m-D25m-0.8m-CAL-CABLE
between the DS-CAL-BOX-DB and Sirius device. After that you connect Counter cables
(L1B7m‑L1B7m‑0.4m) between DS-CAL-BOX-DB and DS-CAL-BOX.
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3.5. Optional temperature and humidity probe

For monitoring temperature and humidity in your laboratory, you can use standard temperature and
humidity probe type HC2A-S frommanufacturer ROTRONIC.
To be able to connect the probe to your PC you need a USB converter type AC3001 which is also
manufactured by ROTRONIC.

Image: ROTRONIC probe and USB converter

Hint
Software is used for reading the data from the probe and sending it directly to the DSCalibrator
software, which can be downloaded directly from a Dewesoft website. Software is named
Environment server.

Hint
We recommend using a different PC for monitoring environmental conditions. In case this is
not possible, you must pay attention to selecting the correct COM port in DSCalibrator.

Important
Keep environmental conditions in the Calibration lab.
Temperature: 23 °C ± 3 °C
Humidity: 45 % ± 33 %
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4. Calibration system equipment configuration

As the next step, configure the calibration system equipment for use by the DSCalibrator. Here are two
setups for the digital multimeter as well as two setups for the multifunction calibrator configuration
described. Select the correct combination of these two according to your existing equipment and follow
all the steps provided by the setup.

4.1. Digital multimeter setup

Power on your multimeter and first of all choose between front or rear side cable connection to the
DS-CAL test board. Switching between the front or rear side plugs is done by pressing the white button
next to the navigation buttons.

4.1.1. Agilent 34410A
DSCalibrator communicates with Agilent 34410A multimeter via ethernet (LAN) connection. Plug in a
LAN cable and start configuring the multimeter.

Enter the Utility menu (Shift + Data Log) → Select Remote I/O → Enter → I/O Port → Select LAN → Enter →
Enable LAN? → Select Yes → Enter → SelectModify → Enter → Reset LAN? → Select No → Enter.

The following settings must be set:
● DHCP → Off
● Auto IP → Off
● IP address (example) → 192.168.10.206
● Subnet mask (example) → 255.255.255.0
● Default gateway → 0.0.0.0
● DNS server → 0.0.0.0
● Host name → (leave blank)
● LAN services → Enable all
● Web Password → Disable

Hint
You should enable DHCP if it is guaranteed that the IP address provided by DHCP won't change
automatically. Otherwise use an unoccupied static IP address as shown by the example above.

4.1.2. Agilent 34401A
DSCalibrator communicates with Agilent 34401A multimeter via serial port (RS 232) connection. Plug in
a serial port cable along with the USB-to-RS232 converter and start configuring the multimeter.

Enter the Setting menu (Shift + <) → Select E: I/O menu → Enter.

The following settings must be set:
● Interface → RS232
● Baud Rate → 9600
● Parity → EVEN 7 BITS
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● Language → SCPI

4.2. Multifunction calibrator setup

Power on your multifunction calibrator and let it warm up prior to usage according to the provided
User’s manual of your multifunction calibrator.

4.2.1. FLUKE 57XX setup
The example below is based on FLUKE 5720A but should apply in similar ways on the FLUKE 57XX series
of multifunction calibrators.

DSCalibrator communicates with FLUKE 5720A multifunction calibrator via a serial port (RS 232)
connection. Plug in a serial port cable along with the USB-to-RS232 converter and start configuring the
multifunction calibrator. For this specific calibrator you will require an additional DSUB25-to-DSUB9
serial port adapter:

Image: DSUB25-to-DSUB9 serial port adapter

Go to Setup Menus → Instmt Setup → Remote Port Setup → Remote Port.
● Select RS 232
● Remote lang → Select Normal

Go to RS 232 Port Setup where the following settings must be set:
● 8 data bits
● 1 stop bit
● Stall → *S/*Q
● Parity → None
● 9600 baud
● Wait → Off
● EOL → CRLF
● Remote I/F → Terminal

Save the configuration by exiting the menus:
Done Setting Port → Done Setting Port → Done Setting Up → Done Setup.
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4.2.2. FLUKE 55XX setup
The example below is based on FLUKE 5502E but should apply in similar ways on the FLUKE 55XX series
of multifunction calibrators.

Go to Setup → Instmt Setup → Remote setup.

● Host → serial

Go to Host setup where the following settings must be set:
● 8 data bits
● 1 stop bit
● Stall → Xon/off
● Parity → None
● 9600 baud
● Remote I/F → Term
● EOL → CRLF

Save the configuration by exiting the menus:
(Prev Menu) → (Prev Menu) → (Prev Menu) → Store changes? → Select Yes → (Prev Menu).

4.3. ROTRONIC HC2A-S temperature and humidity probe setup

HC2A probe uses the RO-ASCII communication protocol, this is the standard (default) communication
protocol used by all AirChip 3000 devices.

Before you start to measure with a new HC2A sensor, you need to download the ROTRONIC HW5
software and configure the sensor to send data to the com port automatically. Follow the next steps:

1. Install ROTRONIC HW5 software and connect an HC2A probe to the USB port of the PC
2. Run the software and click on “Start HW5”.
3. When a message “Add new device to tree?” appears click on button Yes
4. In the left sidebar menu select and open "HC2A" -> Device Manager -> Tools -> Communication

Protocol
5. Select Protocol Type RO-ASCII
6. Select a option "Unsolicited mode (send data automatically)"
7. Click OK, close the software, unplug and plug the sensor back in a USB port (very important step)

Hint
Download link for ROTRONIC HW5 software: HW5 PC-Software

Hint
Software used for reading the data from a probe and sending them directly to the DSCalibrator
software can be downloaded directly from a Dewesoft website. Software is named Environment
server.
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5. Connecting the calibration system together

The next step after setting up the multifunction calibrator and digital multimeter is to establish all
connections of the complete calibration system.

Caution
To avoid damage, first apply the DC power to the DS-CAL test board and then start connecting
all the cables and doing system wiring. Disconnecting should be done in the opposite way
(unplugging the DS-CAL test board at last). It is also recommended to use a separate power
supply for the DS-CAL test board.

5.1. Digital multimeter
Connect as shown by the picture and described by table below.

Image: Front panel connections on multifunction calibrator

Multimeter DS-CAL test board

Input HI Multimeter HI

Input LO Multimeter LO

Input I Multimeter I
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5.2. Multifunction calibrator

Warning
During the calibration procedure voltage up to 1000 V can appear on the output of the used
multifunction calibrator! Use only the 4 mm safety test leads with touch protection and follow
strictly the safety instructions provided by the manual!

Connect as shown by the pictures and described by table below.

Image: Serial connection (left) and front panel connections (right) on multifunction calibrator

Multifunction calibrator DS-CAL test board

Output HI Calibrator IN +

Output LO Calibrator IN ‑

Sense HI Calibrator SENSE +

Sense LO Calibrator SENSE –
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Hint
In case that Fluke 5540A calibrator is used in the calibration process, then you will have to
change the connection of the CAL-BOX to Fluke (in case of devices which also have current
ranges -e.g. IOLITEr-6xSTG) during calibration procedure.. DSCalibrator will display additional

“warning messages'', during calibration of those devices, to inform you that you have to change
connection. Below is a step by step guide on how to do that.

1

5540A calibrator - normal
connection

DS-CAL test board

Output (VZ) HI Calibrator IN +

Output LO Calibrator IN ‑

Sense (VZ) HI Calibrator SENSE +

Sense LO Calibrator SENSE –

Normal front panel connections on multifunction calibrator - Fluke 5540A.

2

DSCalibrator displays warning message - info that you have to change connections from CAL-BOX to
Fluke
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3

5540A calibrator - current
connection

DS-CAL test board

Output (VZ) HI Not connected!

Output LO Calibrator SENSE –

Output VI AUX Calibrator SENSE +

Sense (VZ) HI Not connected!

Sense LO Not connected!

Connect CAL-BOX to Fluke according to the picture and table above. In case that you do not connect
accordingly, the calibration procedure of the current device ranges will fail.

4

When the current “part” of calibration is done, DSCalibrator displays a warning message - info that you
have to change connections from CAL-BOX to Fluke back to normal.

5

5540A calibrator - normal
connection

DS-CAL test board

Output (VZ) HI Calibrator IN +

Output LO Calibrator IN ‑

Sense (VZ) HI Calibrator SENSE +

Sense LO Calibrator SENSE –

Normal front panel connections on multifunction calibrator - Fluke 5540A.
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5.3. DS-CAL test board

The following connections should be done to the DS-CAL test board as described by the picture and
table below. DS-CAL test board connections:

Image: DS-CAL test board back connectors

Depending on different Dewesoft UUT connections, see chapters Sirius USB, DEWE-43, Krypton, and DSI
adapters.

DS-CAL test board Connection description

Calibrator INPUT +, ‑ Connects to the INPUT connectors of the multifunction
calibrator.

Calibrator SENSE +, ‑ Connects to the SENSE connectors of the multifunction
calibrator.

Multimeter HI, LO, and I Connects to the digital multimeter.

PPS* Optional PPS signal input from a precise external time
source.

Sync 1, 2 Connects to the SIRIUS and DEWE-43 UUT.

See chapters Sirius USB and DEWE-43.
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CAN Connects to the SIRIUS and DEWE-43 UUT.

See chapters Sirius USB and DEWE-43.

USB** Connects to the PC.

GND Connects to the UUT and to Calibrator.

Power Power supply provided for the DS-CAL test board.

* If available by the DS-CAL test board (see chapters DS-CAL1 v3 test board).
** If available by the DS-CAL test board (see chapters DS-CAL2 test board).

Hint
TUSB 3410 device driver may be required for the PC to recognize the calibration box.

Important
It is not possible to perform adjustment and calibration of frequency accuracy of the UUTs’
motherboard if PPS signal is not available. Disable the “Frequency test” checkbox in the
DSCalibrator settings if PPS signal is not available to avoid errors during calibration. Disabling

tests is discouraged, however it is the only option if PPS signal is not available.

Important
If DS-GPS-CLOCK is used as a PPS source, please make sure that it is not connected via USB to
the same PC on which you are running DSCalibrator software and performing calibration.
Motherboard calibration tests can fail in this case, even though the UUT is working perfectly.

5.3.1. DS-CAL1 v1 test board
This DS-CAL test board was the first version of the test board available.
It is missing a PPS input connector and it does not support USB.

If used with the Dewesoft UUT without the CAN port, see chapters Dewesoft UUT without CAN port.

5.3.2. DS-CAL1 v3 test board
DS-CAL1 v3 test board features the PPS input connector for precise external time source provided by the
PPS signal.

PPS signal must be connected only if it is required to check also the accuracy of the internal oscillator on
the UUT. Additionally, the “Frequency test” checkbox has to be enabled in the settings of DSCalibrator
software (see chapters External devices).

If used with the Dewesoft UUT without the CAN port, see chapters Dewesoft UUT without CAN port.
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5.3.3. DS-CAL2 test board
DS-CAL2 test board also features the PPS as well as a USB connector.

USB is used for control by the DSCalibrator instead of the CAN port.
It still can be used via CAN port if defined as DS-CAL1 v3 test board in settings of DSCalibrator software
(see chapter External devices).
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6. Software and driver installation

6.1. Installation of the USB-to-serial adapter driver

On the flash drive you will find a folder named \Extras\Driver\UC232A. Open it and run
UC232A_Windows_Setup.exe and follow the installation instructions. Once the installation is finished
proceed to the next step.

6.2. Installation of DSCalibrator software

The self-extract installer DSCalibrator_Installer.exe contains the DSCalibrator software and is intended to
be installed on the PC which will be used for adjustment and calibration of Dewesoft instruments.

● Startup your PC and login with an administrator account.
● Run the self-extract installer “DSCalibrator_Installer.exe” to install the software to C:\DSCalibrator.
● After the installation is finished carefully follow the next chapter about DSCalibrator software

configuration.

Hint
The software versions of DSCalibrator from version 5.0 and onward do not require an installed
Microsoft Excel anymore!

Hint
In case that you see text in red “Dewesoft is not installed” when you installed and first time run
DSCalibrator, then you need to uninstall DSCalibrator and first install the latest version of
Dewesoft and again install DSCalibrator.

Important
Calibration PC overview, basic specifications should be:
● CPU: Preferred Intel i7/i5/(minimum i3) or AMD processor,
● Internal memory: Preferred 16/8/(minimum 4) GB,
● OS: Windows 10/11 preferred, minimum Windows 7/8 (we still support Windows 7/8,

however those are EOL by Microsoft),
● Network: Two network cards preferred, one integrated + one PCIE addon card (integrated

is used for the internet, addon card is used for EtherCAT chain - for Krypton and IOLite
calibration).

● Other specifications (like GPU) are not relevant.
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6.3. Download and run Environment server software

To automatically read the temperature and humidity from the probe and transfer them to the
DSCalibrator, you need additional software. Download Environment server.exe file from a Dewesoft
website and run it.

Image: Environment server software

When you run the software for the first time you need to select:
● Sensor type: “ELPRO HC2A-S”
● Com port: “port of your connected probe”

After all the settings are set the process of collecting data from a probe can be started with a click on the
button “Start server”. If everything is working as it should, temperature and humidity data appear in the
bottom section of the window.

To enable the option of transferring the environmental conditions to the calibration software look at
chapter 7.5. Environment.

Hint
Environment server software supports only the HC2A-S probe frommanufacturer ROTRONIC.

Hint
Environment server software is just optional. You can perform calibration without it, but it saves
you some time because it automatically reads the temperature and relative humidity from the
probe.
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7. Configuring the DSCalibrator software

Run the DSCalibrator software by double-clicking on the DSCalibrator desktop shortcut. When the
DSCalibrator software opens you will immediately see the window “Log-in to database”. Enter your
Username, which is the same as you use to access the Dewesoft ERP system or your Dewesoft account
on the website and the password, which is also the same as for Dewesoft account or ERP account and
click the “OK” button. After that, you are Logged in to the DSCalibrator software under your name. Now
open the menu File → Settings to configure your connected calibration system equipment. After you
review and adjust the settings according to the following chapters make sure to press the OK button to
confirm changes to the settings.

Image: Log-in to database window
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7.1. General settings

● Enter the location of the calibration operator; this information will be shown on the generated
calibration reports.

● Internal calibration is used only in HQ and is not relevant for other locations.
● Optionally an “As Found” or “As Left” comment can be enabled. You can choose which one will be

included in the report after the calibration is finished.
● By enabling custom serial numbers the calibration reports will include your own serial numbers

defined before calibration.
● You can also enable sound playback when the calibration reports are finished.

Image: General settings tab of the DSCalibrator
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7.2. Users

● User is now automatically added to the drop-down menu, selected and shown (if not, you have
to select it from the drop-downmenu) under “Users”

● “Username” is automatically entered
● “Display name” is automatically entered and will be shown on the generated calibration

certificates.
● As an option, your name and an image of your signature can be embedded at the end of the

generated PDF calibration certificates; supported image file types are PNG and JPG
● “Upload calibration reports to global database” is selected as default.
● If you click, under “Get User data from database” on the button “Get data” and enter your

password, a window with your information will appear.

Image: Users tab of the DSCalibrator

Warning
In case you do not have all the needed permissions for the calibration, contact our support team
(Support@dewesoft.com) or directly our calibration team (calibration@dewesoft.com).
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7.3. External devices

Signal generator section:
● Set the multifunction calibrator type to Fluke.
● Select the correct COM port where it is connected. (only available COM ports will be shown). The

easiest way to choose the correct COM port from the USB to RS232 converter is to look for ports
that are available while the other devices are unplugged. Then start plugging in the devices one
by one and simultaneously check for available COM ports. The COM port that is new in the
drop-downmenu is the right one.

● The Certificate no. and Due date can be found on the calibration certificate of your multifunction
calibrator and will be shown on the generated calibration certificates.

Multimeter section:
● Make a selection of the digital multimeter model.
● If you are using a 34401A digital multimeter:
● Select the correct COM port where it is connected.
● Enter the serial number of the digital multimeter; this needs to be done manually.
● If you are using a 34410A / 34465A digital multimeter, you need to type in the IP address that was

configured as a part of the 4.1.1 Agilent 34410A
● The Certificate no. and Due date can be found on the calibration certificate of your digital

multimeter and will be shown on the generated calibration certificates.

Due date warning section:
● When the due date of one or more external devices approaches, you will be warned before

starting the calibration procedure. Here you can set how many days before the expiration date a
warning will be issued.

Dewesoft section:
● Here the right path is already chosen, so do not make any changes unless you have manually

changed the folder structure.
● Dewesoft is normally running in the background during calibration, which you can change if you

check the “Visible” option.

Calibration board section:
● Select DS-CAL 1 (v1) if you have a DS-CAL test board without a PPS connector (see chapters

DS-CAL1 v1 test board)
● In this case the serial number of the DS-CAL test board has to be entered manually.
● Select DS-CAL 1 (v3) if you have a DS-CAL test board with PPS connector (see chapters DS-CAL1

v3 test board)
● Select DS-CAL 2 if you have a DS-CAL test board with USB connector (see chapters DS-CAL2 test

board)
● Enable the “Frequency test” checkbox only if a precise PPS signal from an external time source is

connected to the PPS connector on the DS-CAL test board. If you do not have a precise PPS
signal, disable (uncheck) “Frequency test” otherwise will “motherboard” test on devices fail.
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Image: External devices tab of the DSCalibrator
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7.4. Database

Local database section:
● Select the path where the calibration data (XML files) will be stored.
● By checking “Generate PDF Reports” PDF calibration certificates will be automatically generated

at the end of the calibration procedure.
● By checking “Generate Excel reports” Excel calibration certificates will be automatically generated

at the end of the calibration procedure.
● By checking “Enabling the suffix” the calibration report will have a “fail” or “pass” suffix added to

the end of the file name representing the fail or pass status of device calibration.
● If the “Generate calibration procedure overview report and then run” is checked then the

program chosen in the text box below will be run after the calibration procedure is finished.

Global database section:
● By checking “Enable uploading reports to global database” calibration data will be automatically

uploaded to the Dewesoft server.

Overview report section:
● By changing “Certificate number format” you can define a custom format for the certificate

number of the generated overview report. The format can be defined with the following
variables: %filePrefix, %SystemSN, %yy, %yyyy, %mm and %dd, %counter.

● To define the file prefix as part of the certificate number simply change the “File prefix”.

Image: Database tab of the DSCalibrator
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7.5. Environment

● By checking the “Enable environment server” you enable the environment server which is used
to automatically read the temperature and relative humidity from the probes.

● Enter IP address of the PC, on which is running the Environment server, to section “Host” to
automatically read the temperature and humidity.

Image: Environment tab of the DSCalibrator

7.6. Warmup

● By checking the “Enable instrument warmup” you enable the device to warm-up, before the
calibration process starts. You can define a time limit and a temperature limit.

Image: Warmup tab of the DSCalibrator
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7.7. Advanced
● In the advanced tab you can select and enable special tests.

Image: Advanced tab of the DSCalibrator
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7.8. Tolerance

● The warning limit defines the maximum allowable deviation of the measured value. By default, it
is set to 70 % which means if a channel has an error higher than 70 % of the allowed specification
the channel will be marked in the overview in the color yellow during the calibration process. This
function is used for defining if an adjustment is necessary or not.

● Leave the Tolerance mode at the default setting of “Default”; this means that the error calculation
is done based on the specified accuracy of the system. The setting “Production tolerances” is used
internally for functionality tests and has very tight limits.

Hint
The warning limit is very useful to diagnose if an adjustment should be done; the default value
of 70 % was determined by experience and makes sure that the unit will not be out of tolerance
until the next calibration after a year.

Image: Tolerance tab of the DSCalibrator
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7.9. Custom fields

● You can define a custom logo (for example your company logo) in the first line which will be
shown on the generated PDF calibration certificates; supported image file types are PNG and
JPG.

● Additionally, you can add one or more custom fields which will also show up on the calibration
certificates.

● “Predefined” type will show up as a fixed text on a calibration certificate. A fixed text must be
entered here in the field “Value”.

● “Before Calibration” and “After Calibration” types which you can define before or after calibration
procedure, respectively.

Image: Custom fields tab of the DSCalibrator
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7.10. Experimental

● In the experimental tab, you can enable experimental features.

Caution
These experimental features may change, break or disappear at any time. Wemake absolutely no
guarantees about what may happen if you turn one of these features on.

Image: Custom fields tab of the DSCalibrator
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8. Using the DSCalibrator software

You should now see the screen as displayed below, showing general information about the connected
Dewesoft UUT. Here it is possible to check the firmware version, the internal temperature, and the serial
numbers of the installed modules.

Image: DSCalibrator software overview

There are 3 possible options:
● Adjustment
● Calibration check
● Adjust and Check
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8.1. Adjustment

After clicking on the Adjustment button a window will appear as shown below.
Here it is necessary to adjust the following settings before starting an adjustment procedure:

● Selection of Test groups is performed automatically. Changes to the selection for an adjustment
procedure should be made only if there is a good reason to do so (see chapter Omission of tests).

● Select the modules that you want to make an adjustment on.
● Enter the environmental conditions (ambient temperature and humidity).
● The user (operator) that will perform an adjustment procedure is automatically selected and can

not be changed (DSCalibrator software automatically selects the user who is logged in).
● Check “Disable report generation” if you want to perform the adjustment procedure without

documenting it at the end of the adjustment procedure. The PDF calibration certificate for the
adjustment procedure is never generated anyway.
When ready, press Start to begin with an adjustment procedure.

Image: Prepare adjustment procedure window

Caution
After pressing “Start” the UUT will be immediately adjusted and the existing calibration factors
will be overwritten. If it is necessary to document also the actual state of calibration (“as found”
state) a calibration check must be made before an adjustment!

Hint
If UUT is a Sirius HD UUT, for modules consider selecting the Motherboard and modules 1-4 in
the first pass, and select modules 5-8 in the second pass. Connect appropriately all the channels
according to the chapter Sirius modules.
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8.2. Calibration check

After clicking on the Calibration check button a window will appear as shown below. Here it is necessary
to adjust the following settings before starting a check procedure:

● Selection of Test groups is performed automatically. Changes to selection for calibration check
procedure can be made if this is desired by the user (see chapter Omission of tests).

● Select the modules that you want to make a calibration check on.
● Enter the environmental conditions (ambient temperature and humidity).
● The user (operator) that will perform a calibration check is automatically selected and can not be

changed.
● Check “Disable report generation” if you want to perform the calibration check procedure

without documenting it at the end of the calibration procedure.

Image: Prepare check procedure window

When ready, press Start to begin with the check procedure.

8.3. Adjust and Check

Pressing the Adjust and Check button will automatically start an adjustment and immediately
afterwards a calibration check of the UUT will be performed. Refer to the above-mentioned description
for the detailed settings of both procedures.
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8.4. Calibration procedure

A window similar to shown below will be displayed during the calibration procedure.
● A function/channel currently being performed is marked with black color (for example Excitation

for channel 6 in the image below).
● A channel which was already checked and passed the limits is highlighted in green.
● A function/channel which was already checked passed the limits but exceeds the warning limit

(see chapter Tolerance) is highlighted in yellow. Additionally, the whole function group will be
marked yellow. You can see a detailed description of the deviation by pressing the “Details”
button.

● A function/channel which was already checked but is not within the accuracy limits is highlighted
in red. Additionally, the whole function group will be marked red.

Image: Calibration check procedure in progress

Hint
An adjustment will only affect the accuracy of the Analog IN, analog OUT, and Excitation. It can
not fix failed Noise floor, Filters, TEDS, Counters, and Bridge tests.
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8.5. Special considerations

8.5.1. Omission of tests
Special considerations are required when omitting calibration procedure tests automatically provided by
the DSCalibrator software.

UUT Result

SIRIUS-CHG
SIRIUS-HS-CHG
DSI-CHG-50

Any or all of Analog IN, Noise floor, Filters, TEDS, and Charge tests fail
on adjustment/calibration procedure when Init/Prepare tests are

omitted.

KRYPTON 8xTH/16xTH
Analog IN tests fail on adjustment/calibration procedure when SNR

tests are omitted.

8.5.2. Different module grounding setting
DSCalibrator software will notify if groups of modules require different grounding settings by issuing a
warning before starting a calibration procedure similar to as shown below.

Important
Reported groups of modules must be calibrated separately! Additionally, only connections to
the modules being calibrated must be made to the DS-CAL test board and all others
disconnected!

Image: Warning issued by DSCalibrator when different
module grounding setting is required
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8.5.3. Dewesoft UUT without CAN port
This following applies only if you use an older version of the DS-CAL test board and you have a
Dewesoft UUT without CAN port!

An additional DS-CAN2 instrument must be connected to the PC performing calibration procedure
along with the UUT if any of the following DS-CAL test board versions is used:

● DS-CAL1 v1
● DS-CAL1 v3

Please see chapter DS-CAL test board, to distinguish between different DS-CAL test board versions.
DS-CANmust be connected to the calibration system along with the Dewesoft UUT according to the
Table:

DS-CAN2 Connection description

Power Not connected.

USB Connects to the PC performing calibration
procedure.

CAN1
Connects to the CAN1 connector of the CAN
Y-cable and the other end to the DS-CAL test

board.

CAN2 Connects to the CAN2 connector of the CAN
Y-cable.
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8.6. Custom serial number

DSCalibrator enables you to define your own serial numbers for your devices. These serial numbers will
be seen on the calibration reports and in the DSCalibrator. To define custom serial numbers go to File
and open the “Custom serial numbers editor...”

Image: Open Custom serial numbers editor

A new window will appear:

Image: Custom serial numbers editor

By unlocking the form you are able to add new custom serial numbers. You can add or remove elements
by clicking the “+” and “-” buttons. You can also import and export serial numbers from an XML file or
simply Copy and Paste them to this form. The serial numbers can also be read directly from the system
currently connected to the DSCalibrator and then define a new custom serial number for these devices.
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8.7. Overview report

To create an overview report for a system of devices click on the Database button and choose “Create
overview PDF report...”

Image: Open Create overview PDF report

A new window will appear:

Image: Overview PDF report

To generate an overview report add XML reports to the list. You can add the reports by clicking the “+”
button and choosing a file from a folder on your computer or by clicking the “Find from device” button,
this will check your local database and add the latest found report to the list. After a report is added to
the list you can see a quick overview of its status (serial number of the device, calibration date, and
information whether calibration passed or failed). For each report in the list, you can also choose
whatever you want it to be included in the overview report.

Before merging the reports in the list you can specify the location of where you want to save the report
or change the name of the file, note that the name of the file is also the certificate number of the report.

After clicking the Merge file a new overview report will be generated in the specified location on your
computer.
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8.8. Manual upload of calibration reports to the database

DSCalibrator enables you to manually upload calibration reports to the database. This feature is useful in
case that connection to ethernet (LAN) is not possible at the time of calibration (we recommend that the
PC which is used for calibration is always connected to ethernet).

To manually upload calibration reports you first need to collect all .xml reports of all calibrated modules.
You can find all .xml files on the PC on which calibration was performed. After that follow the next steps:

1. Open DSCalibrator and Log-in.
2. Click on “Database” → “Create PDF report from XML”

Image : DSCalibrator - database
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3. Select .xml files (from which you would like to create PDF report and upload them to database)
and click "Open"

Image: Selecting .xml files

4. Click on “yes” and wait to DSC upload reports to database

Image: Uploading reports to database
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5. Back you receive information that report generation is done

Image: Generation done
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9. Connecting the Sirius UUT

Dewesoft UUTs connect to the calibration system in many different ways according to the different
Dewesoft products. The most common types are described in the following chapters.

Important
Before the calibration, make sure that device is heated up to its working temperature. The
Proposal is to run the UUT for at least 2h, before the start of the calibration.

Important
Whenmaking connections please pay close attention to the channel order on the DS-CAL test
board and UUT and connect appropriately. Additionally, make sure that all connections to the
connectors of UUT are made unless otherwise specified!

9.1. Sirius USB
Connect the Sirius USB UUT as described in the table below. Picture of Sirius USB UUT for reference:

Image: Sirius USB UUT connections

Sirius USB UUT requires the CAN cable, two Sync cables, a USB cable, a power cable, and a banana plug
cable for grounding to be connected. Please note that only the CAN1 connector of the CAN Y-cable
connects to the Sirius USB UUT. There is no distinction between the two Sync connectors.
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Sirius USB UUT Connection

POWER IN Connects to the dedicated power supply.

POWER OUT Not connected.

GND Connects to the GND connector of the DS‑CAL test
board.

USB Connects to the PC.

SYNC (1, 2) Connects to the SYNC (1, 2) connector of the
DS‑CAL test board.

CAN Connects to the CAN connector of the DS‑CAL test
board.

NOTE: Only the CAN1 connector of the CAN Y‑cable
connects the UUT.

The next step is to connect all the modules of the Sirius USB UUT. See chapter Sirius modules.
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9.2. Sirius EtherCAT

Connect the Sirius EtherCAT UUT as described in the table below. Picture of Sirius EtherCAT UUT for
reference:

Image: Sirius EtherCAT UUT connection

Sirius EtherCAT UUT requires the 8-pin LEMO power cable, a USB cable, and a banana plug cable for
grounding to be connected. Sirius EtherCAT UUT must be connected to the PC via USB cable, it is not
possible to perform calibration procedure via EtherCAT connection!

Sirius EtherCAT UUT Connection

ETH IN Connects to the SYNC-JUNCTION “out”

ETH OUT Connects to the dedicated power supply.

USB Connects to the PC.

GND Connects to the GND connector of the DS‑CAL test
board.

Important
For the Sirius EtherCAT UUT please consult the Sirius Technical Reference Manual for
information about ways of connecting power and data connection and usage of proper cables!
Cables for connecting the Sirius EtherCAT UUT are not included in the DS-CAL-BOX package,
see chapter DS-CAL-BOX.

DS-CAL V24-1 54/124



DS-CAL
SOFTWARE USER MANUAL

Important
If you are using the DS-CAL1 v1 or DS-CAL1 v3 test board, you must use and connect DS-CAN2
along with the UUT (see chapter Dewesoft UUT without CAN port)!

Hint
First connect the PS and USB to the UUt. When UUT is recognized by DSCalibrator, connect
SYNC-JUNCTION to UUT and click on refresh the button in the DSCalibrator.

The next step is to connect all the modules of the Sirius EtherCAT UUT. See chapter Sirius modules.
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9.3. Sirius Mini

Connect the Sirius Mini UUT as described in the table below. Picture of Sirius Mini UUT for reference:

Image: Sirius Mini UUT connections

Sirius Mini UUT requires two USB cables, a SYNC connector, and a banana plug cable for grounding
connection.

Sirius Mini UUT Connection

+5V Power supply Connects to the PC.

NOTE: Only USB power is used via this connector.

USB Data Connects to the PC.

NOTE: Only a USB connection to the Sirius Mini UUT is
established via this connector.

SYNC Connects to the DS-SYNC-BOX and then to the both SYNC
connectors of the DS‑CAL test board

GND Connects to the GND connector of the DS‑CAL test board.
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Important
If you are using the DS-CAL1 v1 or DS-CAL1 v3 test board, you must use and connect DS-CAN2
along with the UUT (see chapter Dewesoft UUT without CAN port)!

Important
Before the calibration, run the SIRIUSi Mini for at least 2h. It has to be heated up to working
temperature.

9.3.1. SIRIUSm-3xACC-1xACC+
ACCmodules connect to the DS-CAL test board via a BNC-to-BNC cable to the appropriate ACC (BNC
connector) channel of the DS-CAL test board.

ACC+ module must also have the counter connector connected to the appropriate counter (CNT
connector) channel on the DS-CAL test board.

Image: Example of connecting Siriusm-3xACC-1xACC+ to DS CAL test board
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9.3.2. SIRIUSm-4xACC
ACCmodules connect to the DS-CAL test board via a BNC-to-BNC cable to the appropriate ACC (BNC
connector) channel of the DS-CAL test board.

Image: Example of connecting Siriusm-4xACC to DS CAL test board
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9.4. Sirius modules

Important
Unless otherwise noted, channel 1 on the UUT connects to channel 1 on the DS-CAL test board
and so on for up to all eight UUT channels, respectively.

Important
Sirius HD UUT only: Due to the doubled amount of channels two calibration passes are
required. At first pass connect UUT channels 1 to 8 to the DS-CAL test board’s channels 1 to 8,
respectively. Continue with a second pass by connecting UUT channels 9 to 16 to the DS-CAL
test board’s channels 1 to 8, respectively. You will be notified during the calibration procedure by
the DSCalibrator software which channels should be connected when.

9.4.1. Sirius ACC and HS-ACC
ACC and HS-ACCmodules connect to the DS-CAL test board via a BNC-to-BNC cable to the appropriate
ACC (BNC connector) channel of the DS-CAL test board.

ACC+ and HS-ACC+ modules must also have the counter connector connected to the appropriate
counter (CNT connector) channel on the DS-CAL test board.

Important
ACC+ and HS-ACC+ modules must be calibrated separately because of the required different
grounding settings due to the connected counter channel (see chapter Different module
grounding setting).

Example of connecting 8xACC Sirius modules to DS-CAL test board:

Image: Example of connecting 8xACC Sirius modules to DS-CAL test board
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9.4.2. Sirius CHG and HS-CHG

Important
For the calibration of Sirius CHG or HS-CHG an accessory package CHG CAL ADAPTER is
required (see chapter CHG-CAL-ADAPTER)!

CHG and HS-CHG modules connect to the DS-CAL test board via a BNC-to-BNC cable to the CHG-CAL
adapter’s BNC connector. CHG-CAL adapter plugs into the appropriate MULTI (DSUB15 connector)
channel on the DS-CAL test board.

Example of connecting 4xCHG Sirius modules to DS-CAL test board:

Image: Example of connecting 4xCHG Sirius modules to DS‑CAL test board

The principle of connecting to the CHG-CAL adapter applies also for other available module front
connectors (for example CHG-TNC). CHG+ and HS-CHG+ modules must also have the counter connector
connected to the appropriate counter (CNT connector) channel on the DS-CAL test board.

Hint
If omitting calibration tests for these modules, see chapter Omission of tests.
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9.4.3. Sirius HV and HS-HV
HV and HS-HV modules connect to the DS-CAL test board via the banana cables to the appropriate HV
(BANANA connector) channel of the DS-CAL test board.

Warning
Only HV and HS-HV modules should be connected to the DS-CAL test board’s HV connectors,
unless otherwise noted! During the calibration procedure voltage up to 1000 V can appear on
the output of the used multifunction calibrator! Use only the 4 mm safety test leads with touch
protection and follow strictly the safety instructions provided by the manual!

Example of connecting 4xHS-HV Sirius modules to DS-CAL test board:

Image: Example of connecting 4xHS‑HV Sirius modules to DS‑CAL test board

Hint
For calibration of HV and HS-HV modules consider also the usage of a proper multifunction
calibrator model for filter tests. See table in chapter Multifunction calibrator support.
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9.4.4. Sirius LV and HS-LV

Caution
NEVER connect the LV or HS-LV module to the HV connector on the DS-CAL test board! If Sirius
UUT contains mixed modules (for example a combination of LV and HV modules with banana
fronts) make sure NOT to connect the LV or HS-LV modules to the HV connector on the DS-CAL
test board as this will incur permanent damage to the LV or HS-LV module! Always connect LV
or HS-LV modules according to the Table below.

LV and HS-LV modules connect to the DS-CAL test board:

Module (Connector) DS-CAL test board channel (Connector)

LV (DSUB9), HS-LV (DSUB9) DEWE-43/STG (DSUB9)

LV (BNC), HS-LV (BNC) ACC (BNC)

LV (BANANA), HS-LV (BANANA) ACC (BNC via BANANA-to-BNC adapter)

Example of connecting 4xHS-LV Sirius modules with Banana fronts to the DS-CAL test board:

Image: Example of connecting 4xHS LV Sirius modules with Banana fronts to the DS CAL test board

LV+ and HS-LV+ modules must also have the counter connector connected to the appropriate counter
(CNT connector) channel on the DS-CAL test board.
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9.4.5. Sirius MULTI
MULTI modules connect to the DS-CAL test board via a DSUB15-to-DSUB15 cable to the appropriate
MULTI (DSUB15 connector) channel of the DS-CAL test board.

Caution
In case, that Sirius device with MULTI channels also has AO channels on the back of the device,
make sure that the AO channels are disconnected from CAL-BOX in time of MULTI channels
calibration. In this case you have to calibrate MULTI channels separately and AO channels on the
back separately, otherwise calibration fails.

9.4.6. Sirius STG and STGM
STG and STGMmodules connect to the DS-CAL test board via a DSUB9-to-DSUB9 cable to the
appropriate DEWE-43/STG (DSUB9 connector) channel of the DS-CAL test board.

The principle of connecting to the appropriate DEWE-43/STG (DSUB9 connector) channel on the
DS-CAL test board channel applies also for other available module front connectors (for example STG
L2B7f, STG L2B10f, STGM L2B8f, STGM L2B16f, and others).
STG+ and STGM+modules must also have the counter connector connected to the appropriate counter
(CNT connector) channel on the DS-CAL test board.

Example of connecting the 8xHS-STG Sirius modules to the DS-CAL test board:

Image: Example of connecting 8xHS‑STG Sirius modules to the DS‑CAL test board
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9.4.7. Sirius HD-ACC
HD-ACC connect to the DS-CAL test board via a BNC-to-BNC cable to the appropriate ACC (BNC
connector) channel of the DS-CAL test board:

Module (Connector) DS-CAL test board channel (Connector)

HD-ACC (BNC), channels 1-8 ACC (BNC), channels 1-8

HD-ACC (BNC), channels 9-16 ACC (BNC), channels 1-8

Example of connecting the first half of 8xHD-ACC Sirius modules to the DS-CAL test board:

Image: Example of connecting the first half of 8xHD‑ACC Sirius modules to the DS‑CAL test board
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9.4.8. Sirius HD-LV
LV and HS-LV modules connect to the DS-CAL test board:

Module (Connector) DS-CAL test board channel (Connector)

HD-LV (DSUB9), channels 1-8 DEWE-43/STG (DSUB9), channels 1-8

HD-LV (DSUB9), channels 9-16 DEWE-43/STG (DSUB9), channels 1-8

HD-LV (BNC), channels 1-8 ACC (BNC), channels 1-8

HD-LV (BNC), channels 9-16 ACC (BNC), channels 1-8

Example of connecting the second half of 8xHD-LV Sirius modules to the DS-CAL test board:

Image: Example of connecting the second half of 8xHD LV Sirius modules to the DS CAL test board
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9.4.9. Sirius HD-STGS and SIRIUS-HD-16xSTGS-L1B10f
HD-STGS modules connect to the DS-CAL test board:

Module (Connector) DS-CAL test board channel (Connector)

HD-STGS (DSUB9), channels 1-8 DEWE-43/STG (DSUB9), channels 1-8

HD-STGS (DSUB9), channels 9-16 DEWE-43/STG (DSUB9), channels 1-8

HD-STGS (DSUB15), channels 1-8 MULTI (DSUB15), channels 1-8

HD-STGS (DSUB15), channels 9-16 MULTI (DSUB15), channels 1-8

The principle of connecting to the appropriate connector on the DS-CAL test board channel applies also
for other available module front connectors not listed in the table above.

Example of connecting the first half of 8xHD-STGS Sirius modules to the DS-CAL test board:

Image: Example of connecting the first half of 8xHD STGS Sirius modules to the DS CAL test board

Important
For the calibration of SIRIUS-HD-16xSTGS-L1B10f UUT special (L1B10m-D9M) cables are
required! Contact our support team for more information.
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9.4.10. Sirius AO
The AOmodule connects to the DS-CAL test board via a BNC-to-BNC cable to the appropriate AO (BNC
connector) channel of the DS-CAL test board. All eight channels must be connected and calibrated at
once.

Example of connecting the Sirius AOmodule to the DS-CAL test board:

Image: Example of connecting the Sirius AOmodule to the DS‑CAL test board

Image: Example of connecting the SIRIUS-8xAO to the DS‑CAL test board
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9.5. SIRIUSiwe

Connect the SIRIUSiwe UUT as shown on the image and as described by the Table below.

Image: SIRIUSiwe UUT connections

SIRIUSWe Connection

ETH IN Connects to the SYNC-JUNCTION “OUT”
connector.

ETH OUT Connects to the dedicated power supply.

USB Connects to the PC.

Important
Before the calibration, run the SIRIUSiwe for at least 2h. It has to be heated up to working
temperature.
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9.5.1. SIRIUSiwe-6xSTGM-2xSTGM+

STGMmodules connect to the DS-CAL test board via a DSUB9-to-DSUB9 cable to the appropriate
DEWE-43/STG (DSUB9 connector) channel of the DS-CAL test board. STGM+modules must also have the
counter connector connected to the appropriate counter (CNT connector) channel on the DS-CAL test
board.

Important
Before the calibration, run the Sirius UUT for at least 2h. It has to be heated up to working
temperature.

Image: Example of connecting 6xSTGM-2xSTGM+modules to the DS‑CAL test board
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9.6. MINITAURs

MINITAURs is a special device, it has 8 x analog and 8 x advanced counter inputs, basically it is like Sirius
8x STG-M+, with the difference that it has integrated CPU with removable SSD.
Due to the integrated CPU, the calibration process is a little different from the normal Sirius 8x STG-M+.

Image: MINITAURs

To calibrate this UUT, the following options are available:

1. The best option is to have a replacement disk with all the installed and necessary
software, which is needed for the calibration and swapping the disk for the time of the
calibration.

2. Similar alternative is to download and install the DSCalibrator software on the device and
perform the calibration process on the device itself. We do not recommend this option,
because this process requires installation of additional software and drivers on the
inserted disk, which the owner of the MINITAURs may not desire (the same applies for the
SBOX instruments).

3. Another alternative is to send MINITAURs to the Dewesoft HQ, where the UUT is
disassembled (the computer part is separated from the UUT). The calibration is performed
on the UUT independently from the computer. In this case no installation of software and
drivers is required.
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How to connect MINITAURs to the CAL-BOX is presented on the picture and table below:

Image: MINITAURs UUT connections

MINITAURs Connection

POWER Connects to the dedicated power supply.

Slice SYNC (1, 2) Connects to the SYNC (1, 2) connector of the DS‑CAL test board.

USB Connects to the CAL-BOX and Multifunction calibrator.

GND Connects to the GND connector of the DS-CAL test board.

CAN1 Connects to the DS-CAL test board via a CAN1 connector of the
CAN Y-cable.
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Important
Before calibration all the external devices (multifunction calibrator, multimeter and DS-CAL test
board) must be connected to the MINITAURs and have all the necessary software and drivers
installed before calibration can be performed.

Hint
Additional accessories are needed (computer screen, keyboard and mouse) to be able to
perform calibration.

Image: Example of connecting STGM+modules to the DS‑CAL test board
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9.7. Sirius-HS and Siriusi-HS

Connect the Sirius-HS and Siriusi-HS UUT as described in the table below. Picture of Sirius USB UUT for
reference:

Image: Sirius-HS and Siriusi-HS UUT connections

Sirius-HS and Siriusi-HS devices require the CAN cable, two Sync cables, a USB cable, a power cable, and
a banana plug cable for grounding to be connected. Please note that only the CAN1 connector of the
CAN Y-cable connects to the Sirius USB UUT. There is no distinction between the two Sync connectors.

Sirius/i-HS UUT Connection

POWER IN Connects to the dedicated power supply.

POWER OUT Not connected.

GND Connects to the GND connector of the DS‑CAL test
board.

USB Connects to the PC.

SYNC (1, 2) Connects to the SYNC (1, 2) connector of the
DS‑CAL test board.
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CAN Connects to the CAN connector of the DS‑CAL test
board.

NOTE: Only the CAN1 connector of the CAN Y‑cable
connects the UUT.

Important
Sirius High Speed devices with HV, LV or STG modules must be calibrated on FLUKE 57XX series.
Calibration is possible with 55XX series, but extended filter tests will not be done (the whole
functionality of the UUT will not be tested)!!

Important
Sirius high speed devices with ACCmodules can be calibrated on FLUKE 57XX or 55XX series.
The whole functionality of UUT can be tested also on FLUKE 55XX series.

Hint
Sirius high speed modules connect to the DS-CAL-box the same way as the Sirius USB or Sirius
EtherCAT modules.

The next step is to connect all the modules of the Sirius-HS to CAL-BOX. See chapter Sirius modules.
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9.8. Siriusi-XHS

Connect the Siriusi-XHS UUT as described in the table below. Picture of Siriusi-XHS UUT for reference:

Image: Siriusi-XHS

Siriusi-XHS UUT Connection

POWER IN Connects to the dedicated power supply.

POWER OUT Not connected.

GND Connects to the GND connector of the DS‑CAL test
board.

USB Connects to the PC.

SYNC (1, 2) Connects to the SYNC (1, 2) connector of the
DS‑CAL test board.

CAN Connects to the CAN connector of the DS‑CAL test
board.

NOTE: Only the CAN1 connector of the CAN Y‑cable
connects the UUT.

GLAN Not connected.
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Important
Sirius Extra High Speed devices must be calibrated on FLUKE 57XX series. Calibration is possible
with 55XX series, but extended filter tests will not be done (the whole functionality of the UUT
will not be tested)!!

Important
Before the calibration, make sure that device is heated up to its working temperature. The
Proposal is to run the UUT for at least 1h-2h, before the start of the calibration

Hint
Before calibration it is not necessary to connect CAN and SYNC connections. Motherboard tests
are not supported yet, therefore after calibration the report for motherboard is not created and
motherboard calibration date is not updated.

Some XHS modules require terminators during calibration procedure. Table below shows which
modules require terminators and which terminators you have to use.

XHS module type Terminator

LV (DSUB9 type of connector) D9M-BNC adapter + BNC terminator

LV (BANANA type of connector) Shorting bar

LV (BNC type of connector) BNC terminator

The next step is to connect all the modules of the Sirius-XHS to CAL-BOX. See chapter Sirius modules.
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10. DEWE-43

Caution
Before connecting DEWE-43 UUT to the DS-CAL test board, make sure that the DS CAL test
board has a power supply connected! If not, permanent damage might incur to the DS CAL test
board.

Connect the DEWE-43 UUT as shown on the picture and as described by the table below. DEWE-43 UUT
connects to the calibration system in a very similar manner as the Sirius UUT but is mentioned here due
to its different looks and two CAN interfaces. DEWE-43 UUT requires the CAN Y cable, two Sync cables, a
USB cable, a power cable, and a banana plug cable for grounding to be connected. Please note that
both CAN1 and CAN2 connectors of the CAN Y cable connect to the DEWE-43 UUT. There is no
distinction between the two Sync connectors.

Image: DEWE-43 UUT connections

DS-CAL V24-1 77/124



DS-CAL
SOFTWARE USER MANUAL

Image: Example of connecting DEWE-43 to the DS‑CAL test board

DEWE-43 Connection

POWER IN Connects to the dedicated power supply.

SYNC (1, 2) Connects to the SYNC (1, 2) connector of the DS‑CAL test board.

USB Connects to the PC.

GND Connects to the GND connector of the DS-CAL test board.

CAN1 Connects to the DS-CAL test board via a CAN1 connector of the
CAN Y-cable.

CAN2 Connects to the DS-CAL test board via a CAN2 connector of the
CAN Y-cable.

AI (DSUB9), channels 1-8 Connects to the appropriate DS-CAL test board’s DEWE-43/STG
(DSUB9 connector) channels.

CNT (LEMO7), channels 1-8 Connects to the appropriate DS-CAL test board’s counter (CNT
connector) channels.
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11. Krypton

11.1 Krypton Modular multi

Important
For connecting the Krypton UUT to the PC via a network connection a dedicated network
device must be used! It is not allowed to connect via a network switch, hub or a router!
Therefore, a PC with two network devices is required if at least one network device is used to

connect the PC to the internet (or intranet).

Important
If you are using the DS-CAL1 v1 or DS-CAL1 v3 test board, you must use and connect DS-CAN2
along with the UUT (see chapter Dewesoft UUT without CAN port)!

Important
Unless otherwise noted, the channel 1 on the UUT connects to the channel 1 on the DS-CAL test
board and so on for up to all eight UUT channels, respectively.

Krypton UUT requires a power cable (8-pin LEMO) and a network connection to the PC connected.
Connect the Krypton UUT:

Image: KRYPTONi-16xTH-HS UUT connections
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Krypton UUT Connection

IN Ethernet connection to the PC.

OUT Power supply for the UUT.

The next step is to connect all the channels of the Krypton UUT, which is described in the following
chapters.

Important
For the Krypton UUT please consult the Krypton Technical Reference Manual for information
about ways of connecting power and data connection and usage of proper cables! Cables for
connecting the Krypton UUT are not included in the DS-CAL-BOX package, see chapter
DS-CAL-BOX.

11.1.1. Krypton 8xTH, 16xTH

Important
For the calibration of Krypton 8xTH / 16xTH UUT an accessory package KRYPTON-TH-CAL-SET is
required (see chapter KRYPTON-TH-CAL-SET)! Consider also the usage of a supported
multifunction calibrator (see chapter Multifunction calibrator support)!

Krypton TH channels connect directly to the multifunction calibrator using a 1-to-8 or 1-to-16
male-to-male splitter T-type thermocouple cable. Thermocouple cables need to be of hi-precision type.
All channels must be connected and calibrated at once.

Hint
Because of the nature of thermocouple cables having a temperature dependent voltage drop,
shorting of thermocouple input channels is required at one point during calibration. Use the
provided white thermocouple terminators. You will be informed by the DSCalibrator software
during the calibration procedure when shorting is required.
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Example of connecting the Krypton 8xTH channels:

Image: Example of connecting the Krypton 8xTH channels using T‑type thermocouple cable

11.1.2. Krypton 4xLV, 8xLV

Krypton LV channels connect to the DS-CAL test board via a BNC-to-BNC cable to the appropriate ACC
(BNC connector) channel of the DS-CAL test board. All channels must be connected and calibrated at
once.

Example of connecting the Krypton 4xLV channels to the DS-CAL test board:

Image: Example of connecting the Krypton 4xLV channels to the DS‑CAL test board
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11.1.3. Krypton-3 x STG, Krypton-6xSTG

Krypton STG channels connect to the DS-CAL test board via a DSUB9-to-DSBU9 cable to the appropriate
DEWE-43/STG (DSUB9 connector) channel of the DS-CAL test board. All channels must be connected
and calibrated at once.

Example of connecting the Krypton 3xSTG channels to the DS-CAL test board:

Image: Example of connecting the Krypton 3xSTG channels to the DS-CAL test board

DS-CAL V24-1 82/124



DS-CAL
SOFTWARE USER MANUAL

11.1.4. Krypton RTD

Important
For the calibration of Krypton RTD UUT special cables are required! Contact our support team
for more information.

Krypton RTD channels connect to the DS-CAL test board via an L0B6m-to-DSUB15 cable to the
appropriateMULTI (DSUB15 connector) channel of the DS-CAL test board. All channels must be
connected and calibrated at once.

Example of connecting the Krypton 8xRTD channels to the DS-CAL test board:

Image: Example of connecting the Krypton 8xRTD channels to the DS‑CAL test board
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11.1.5. Krypton 4xACC, 8xACC

Krypton ACC channels connect to the DS-CAL test board via a BNC-to-BNC cable to the appropriate ACC
(BNC connector) channel of the DS-CAL test board. All channels must be connected and calibrated at
once. During noise floor tests it is necessary to disconnect the cables and connect the 50 Ω terminators
(and then back).

Hint
You will be informed by the DSCalibrator software during the calibration procedure when 50 Ω
terminators are required.

Example of connecting the Krypton 4xACC channels to the DS-CAL test board:

Image: Example of connecting the Krypton 4xACC channels to the DS‑CAL test board
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11.2. Krypton Modular one

Important
For connecting the Krypton UUT to the PC via a network connection a dedicated network
device must be used! It is not allowed to connect it via a network switch, hub or a router!
Therefore, a PC with two network devices is required if at least one network device is used to
connect the PC to the internet (or intranet).

Krypton UUT requires a power cable (8-pin LEMO) and a network connection to the PC connected.
Connect the Krypton UUT as described by the table below.

Image: KRYPTON 1xTH-HV connections

Krypton UUT Connection

IN Ethernet connection to the PC.

OUT Power supply for the UUT.
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11.2.1. Krypton 1 x AO
Krypton one AO channel connects to the DS-CAL test board via a BNC-to-BNC cable to the appropriate
AO (BNC connector) channel of the DS-CAL test board.

Image: Example of connecting the Krypton 1xAO channel to the DS‑CAL test board

11.2.2. Krypton 1xCNT
Krypton one CNT channel connects to the appropriate counter (CNT connector) channel on the
DS-CAL test board.

Image: Example of connecting the Krypton 1xCNT channel to the DS‑CAL test board
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11.2.3. Krypton 1xTH-HV
The Krypton TH-HV channel connects directly to the multifunction calibrator using a KRYPTON
TH-HV-CAL-CABLE.

Image: Example of connecting the KRYPTONi-1xTH-HV channel

11.2.4. Kryptoni 1xLV

The Kryptoni 1xLV channel connects to the appropriate ACC (BNC connector) channel on the DS-CAL
test board.

Image: Example of connecting the Kryptoni 1xLV
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12. IOLITE

12.1. IOLITE R12, R8, LX-R8, R8r

Important
For connecting the IOLITE UUT to the PC via a network connection a dedicated network device
must be used! It is not allowed to connect it via a network switch, hub or a router! Therefore, a
PC with two network devices is required if at least one network device is used to connect the PC
to the internet (or intranet).

Hint
If you want to calibrate only modules and not the IOLITE gate, then it is not necessary to
connect SYNC 1 and 2 to the DS-CAL test board.

Caution
Be careful when removing IOLite slices from the frame. Before removing the slice, turn off the
power source or unplug the device from the power supply. The same applies for inserting the
slices back in.

Connect the IOLITE R12 UUT as described by the Table and Image below.

Image: IOLITE R12 UUT connections
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IOLITE R12 requires two Sync cables, a power cable and an Ethernet cable.

IOLITE R12 Connection

POWER IN Connects to the dedicated power supply.

SYNC (1, 2) Connects to the SYNC (1, 2) connector of the DS‑CAL test
board.

EtherCAT BUS1 IN Ethernet connection to the PC.

EtherCAT BUS1 OUT Not connected.

EtherCAT BUS2 IN Not connected.

EtherCAT BUS2 OUT Not connected.

Connect the IOLITE R8 UUT as described by the Table and image below.

Image: IOLITE R8 UUT connections
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IOLITE R8 Connection

POWER IN Connects to the dedicated power supply.

SYNC (1, 2) Connects to the SYNC (1, 2) connector of the DS‑CAL test
board.

EtherCAT IN Connection to the PC.

EtherCAT OUT Not connected.

ETH1 Not connected.

ETH2 Not connected.

Hint
IOLite LX-R8 and R8r connections are the same as for the IOLITE R8.
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12.1.1. IOLITEir-8xTH and 8xTH-HS

Important
For the calibration of IOLITEir-8xTH and 8xTH-HS an accessory package KRYPTON-TH-CAL-SET
is required (see chapter KRYPTON-TH-CAL-SET)! Consider also a usage of a supported
multifunction calibrator (see chapter Multifunction calibrator support)!

IOLITE TH channels connect directly to the multifunction calibrator using a 1-to-8 male-to-male
splitter T-type thermocouple cable. Thermocouple cables need to be of hi-precision type. All channels
must be connected and calibrated at once.

Hint
Because of the nature of thermocouple cables having a temperature dependent voltage drop,
shorting of thermocouple input channels is required during calibration. Use the provided white
thermocouple terminators. You will be informed by the DSCalibrator software
during the calibration procedure when shorting is required.

12.1.2. IOLITEr-4xCNT

IOLITE counter connectors connect to the appropriate counter (CNT connector) channel on the
DS-CAL test board.

Image: Example of connecting the IOLITEr-4xCNT to the DS‑CAL test board
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12.1.3. IOLITEr-8xSTGS

IOLITE STGS channels connect to the DS-CAL test board via aT2B9f -to-D9m cable to the appropriate
STG (DSUB9 connector) channel of the DS-CAL test board. All channels must be connected and
calibrated at once.

Image: Example of connecting the IOLITEr-8xSTGS to the DS‑CAL test board

12.1.4. IOLITEr-6xSTG
IOLITE STG channels connect to the DS-CAL test board via a DSUB9-to-DSBU9 cable to the appropriate
STG (DSUB9 connector) channel of the DS-CAL test board. All channels must be connected and
calibrated at once.

Image: Example of connecting the IOLITEr-6xSTG to the DS‑CAL test board
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12.2. IOLite multi-channel

Important
Before connecting power cable to IOLite multi-channel, remove included
“POWER-IN/POWER-OUT” connectors. These connectors are included so it is possible to use
customers’ own power supply cable.

Important
For connecting the IOLite multi-channel UUT to the PC via a network connection a dedicated
network device must be used! It is not allowed to connect it via a network switch, hub or a
router! Therefore, a PC with two network devices is required if at least one network device is
used to connect the PC to the internet (or intranet).

Connect the IOLite multi-channel UUT as described by the Table below. IOLite multi-channel requires a
special 2-pin power cable.

Image: IOLITE multi UUT connections

IOLITE Connection

POWER OUT Not connected.

POWER IN Connects to the dedicated power supply.

ECAT OUT Not connected.
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ECAT IN Ethernet connection to the PC.

12.2.1. IOLITEi-8xRTD and IOLITEi-8xRTD-T2A4f

IOLITEir RTD channels connect to the DS-CAL test board via a L0B6m-to-DSBU15 cable to the
appropriateMULTI (DSUB15 connector) channel of the DS-CAL test board. All channels must be
connected and calibrated at once.

Image: Example of connecting the IOLITEi-8xRTD to the DS‑CAL test board

Important
For the calibration of IOLITEi-8xRTD-T2A4f UUT special (D15M-TBLOCK4-CAL-CABLE) cables are
required! Contact our support team for more information.
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Image: Example of connecting the IOLITEi-8xRTD-T2A4f to the DS‑CAL test board

12.2.2. IOLITEi-8xTH and 8xTH-HS

Important
For the calibration of IOLITEi-8xTH and 8xTH-HS an accessory package KRYPTON-TH-CAL-SET is
required (see chapter KRYPTON-TH-CAL-SET)!
Consider also a usage of a supported multifunction calibrator (see chapter Multifunction
calibrator support)!

IOLITE TH channels connect directly to the multifunction calibrator using a 1-to-8 male-to-male
splitter T-type thermocouple cable. Thermocouple cables need to be of hi-precision type. All channels
must be connected and calibrated at once.

Hint
Because of the nature of thermocouple cables having a temperature dependent voltage drop,
shorting of thermocouple input channels is required during calibration. Use the provided white
thermocouple terminators. You will be informed by the DSCalibrator software
during the calibration procedure when shorting is required.
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Image: Example of connecting the IOLITEi-8xTH
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12.2.3. IOLITE-6xSTG

IOLITE STG channels connect to the DS-CAL test board via a DSUB9-to-DSBU9 cable to the appropriate
STG (DSUB9 connector) channel of the DS-CAL test board. All channels must be connected and
calibrated at once.

Image: Example of connecting the IOLITEir 6xSTG channels to the DS‑CAL test board

DS-CAL V24-1 97/124



DS-CAL
SOFTWARE USER MANUAL

12.2.4. IOLITEi-8xLA-T2A2f

IOLITE LA channels with T2A2f type of connector connect to the DS-CAL test board via BNC-to-T2B2m
cable to appropriate ACC (BNC connector) channel of the DS-CAL test board. All channels must be
connected and calibrated at once.

Image: Example of connecting the IOLITEi-8xLA-T2A2f channels to the DS‑CAL test board

Hint
For the calibration of IOLITEi devices with T2A2f type of connector special BNC-to-T2B2m cables
are required! Please look at chapter 3.4.3. IOLITE-CAL-SET.
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13. DSI adapters

Important
For the calibration of DSI adapter UUT an accessory package DSI CAL SET is required (see
chapter DSI-CAL-SET)!

Important
An isolated SIRIUS instrument is also required (SIRIUSi 8xSTG is prefered), however,
Sirius HS and HD, Krypton, and Sirius XHS devices are not supported for calibration of DSI
adapters.

Start by connecting the DSI CAL ADAPTER and DSI EXC BNC together via BNC-to-BNC cable as shown
below. Connect also a SIRIUS instrument (see chapter Sirius USB, respectively) but without connecting
any modules to the DS CAL test board.

Image: DSI connection cable

Steps to connect the DSI adapter UUT are as follows:
● DSI CAL ADAPTER connects to one of eightmodule (DSUB9 connector) channels on SIRIUS.
● The other end of the cable with DSI EXC BNC adapter connects to the appropriate DS-CAL test

board’s DEWE-43/STG (DSUB9 connector) channel.
● On top of the DSI, CAL ADAPTER connects a DSI adapter UUT.
● The connection between the DSI adapter UUT and the DS-CAL test board depends on the type of

the DSI adapter UUT. DSI adapter UUT input connects according to the following chapters.
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To calibrate a DSI adapter UUT select the DSI tab in the DSCalibrator software:

Image: DSCalibrator software overview in DSI mode

Connected DSI adapter UUTs are detected when mode is changed to DSI. Clicking on the Refresh button
re-detects and re-reads the information about the connected DSI adapter UUTs.

Calibration of some DSI adapters requires a predefined charge adapter. Defining the properties (such as
serial number, certificate number, and capacitor value) of these charge adapters is done in the Charge
adapters editor accessible by clicking the File button. Click the Unlock button and add the charge
adapter and its properties.

Image: Charge adapters editor

The list of defined charge adapters is accessible in the DSI adapters grid in the Cal adapter column.
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13.1. DSI-ACC, DSI-ACC-0.16Hz, DSI-ACC-20mA

DSI-ACC, DSI-ACC-0.16Hz, and DSI-ACC-20mA connect to the DS-CAL test board via a BNC-to-BNC cable
to the appropriate ACC (BNC connector) channel of the DS-CAL test board.

Example of connecting the 4xDSI-ACC to the DS-CAL test board:

Image: Example of connecting the 4xDSI‑ACC to the DS CAL test board

Important
Calibration procedure will fail if you use Agilent 34401A DMM (also a warning window appears
before start ). Use any other supported DMM for DSI-ACC calibration.
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13.2. DSI-V-200

DSI-V-200 connects to the DS-CAL test board via a BNC-to-BNC cable and a Banana-to-BNC adapter to
the appropriate HV (BANANA connector) channel of the DS-CAL test board.

Important
Do not calibrate more than four DSI-V-200 adapters at once!
This is a limitation due to the input impedance of the DSI-V-200 adapters.

Example of connecting the DSI-V-200 to the DS-CAL test board:

Image: Example of connecting the DSI-V-200 to the DS-CAL test board
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13.3. DSI-CHG-50, DSI-CHG-100 and DSI-CHG-DC

Important
For the calibration of DSI-CHG-50 and DSI-CHG-100 adapter UUT an accessory package CHG
CAL ADAPTER is required (see chapter CHG-CAL-ADAPTER)!
The calibration of DSI-CHG-DC requires a 100 nF ISO calibrated capacitor.

Important
For the calibration of DSI-CHG-DC adapter UUT a 100 nF ISO calibrated capacitor is required.

DSI-CHG-50 and DSI-CHG-100 connects to the CHG-CAL adapter via a BNC-to-BNC cable and the
CHG-CAL adapter connects to the appropriate MULTI (DSUB15 connector) channel of the DS-CAL test
board.

DSI-CHG-DC connects to the 100 nF capacitor via a BNC-to-BNC cable and the 100 nF capacitor
connects to the appropriate ACC (BNC connector) channel of the DS-CAL test board.

Example of connecting the DSI-CHG-50 to the DS-CAL test board:

Image: Example of connecting the DSI-CHG-50 to the DS-CAL test board
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13.4. DSI-TH-K, DSI-TH-T, DSI-TH-J, DSI-TH-C, DSI-TH-B and DSI-TH-E

Important
For the calibration of DSI-TH adapter UUT a proper thermocouple cable type is required (for
example DSI-TH-K uses K-type thermocouple cable)! Consider also a usage of a supported
multifunction calibrator (see chapter Multifunction calibrator support)!

Hint
Thermocouple cable colors can vary around the world.

DSI-TH connects directly to the multifunction calibrator using a 1-on-1 thermocouple cable of the
appropriate type according to the table below. Thermocouple cables need to be of hi-precision type.

Example of connecting the DSI-TH-K:

Image: Example of connecting the DSI-TH-K

DSI adapter UUT Connection (cable color according to standard IEC 60584-3)

DSI-TH-K Connects using a K‑type thermocouple cable (green).

DSI-TH-T Connects using a T‑type thermocouple cable (brown).

DSI-TH-J Connects using a J‑type thermocouple cable (black).

DSI-TH-C Connects using a C‑type thermocouple cable (red).

DSI-TH-B Connects using a B-type thermocouple cable (gray).

DSI-TH-E Connects using an E‑type thermocouple cable (purple).
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13.5. DSI-RTD

Important
For the calibration of DSI RTD adapter UUT special DSI-RTD-CAL-CABLE is required! Contact our
support team for more information.

Hint
On DSI-RTD-CAL-CABLE you can find marks of how to connect it to Fluke calibrator.

DSI-RTD connects directly to the multifunction calibrator using a Binder-to-4xBanana cable. Due to a
usage of a special cable, only one adapter can be calibrated at once!

An example of connecting the DSI-RTD:

Image: Example of connecting the DSI-RTD

Image: Example of connecting the DSI-RTD-CAL-CABLE to Fluke
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13.6. DSI-5A

Important
For the calibration of DSI 5A adapter UUT an accessory package DSI-5A-CAL-CABLE is required
(see chapter DSI-5A-CAL-CABLE)!

DSI-5A connects directly to the multifunction calibrator using a DSI-5A-CAL-CABLE cable. Due to a
usage of a special cable, only one adapter can be calibrated at once!

DSI-5A-CAL-CABLE’s banana connectors connect as shown below and an example of connecting the
DSI-5A follows.

Image: Example of connecting DSI-5A-CAL-CABLE
to the FLUKE 5502E multifunction calibrator
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Image: Example of connecting the DSI-5A

Hint
The DSIi-10A and DSIi-20A adaptors have to be connected with Banana-to-Banana connectors
to the Fluke instrument. The DSI-20mA has spring connectors right on the PCB, so they are
shipped to the customer disassembled (so the connection can be made according to the
customers’ wishes). Regardless of the connector used, it is necessary to connect the DSI-20mA
adapter to the ACC channels on the CAL-BOX.
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13.7. DSI-CHG-CAL

Important
For the calibration of DSI-CHG-CAL adapter an ISO calibrated 1nF capacitor is required. The
capacitor properties need to be defined in the Charge adapter editor.

To define capacitor properties, open DS Calibrator and go to File → Charge adapter editor. When the new
window appears you first need to click on “Unlock” and then click on “+ to add capacitor. Enter capacitor
serial number, value (from ISO calibration report - measured), certificate nr., Calibration date, and Exp.
date fulfills automatically. After you successfully defined the capacitor, you click on “Lock” and “OK”.

Image: Charge adapter editor with defined 1nF capacitor

The DSI-CHG-CAL adapter connects to the appropriate MULTI (DSUB15 connector) channel and the
capacitor connects to the appropriate ACC channel of the DS-CAL test board. The DSI-CHG-CAL adapter
then connects to the CHGmodule on chosen instrument via a BNC-to-BNC cable, during the calibration
a window will appear asking to connect the BNC-to-BNC cable from DSI-CHG-CAL adapter to the
capacitor.

In order to read the data from the DSI-CHG-CAL adapter you must change the mode of the DS-CAL test
board. To do that right click on the DSI adapters grid and select “Charge adapter calibration” from the
menu. Before starting the calibration procedure choose the correct capacitor from the drop downmenu
in the DSI adapters grid in the “Cal adapter” column. Note that only one CHG-CAL adapter can be
calibrated at once.
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Image: Example of connecting the DSI-CHG-CAL adapter to the DS CAL test board

When you finish with calibration you need to upload DSI-CHG-CAL adapters to the Charge adapter
editor, so they are automatically read next time when they are used for calibration of SIRIUS-CHG and
SIRIUS-HS-CHGmodules and for DSI-CHG-50 adapters.
To upload DSI-CHG-CAL adapters you need to first open the Charge adapter editor and then click on
“Read from device”. After that, DSI-CHG-CAL adapters which are currently connected to the CAL box
CHGmodule as shown in the picture above, appear in the Charge adapter editor.
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14. Appendix A: Connectors of the DS-CAL test board

14.1. CAN connector

Pin Name Description

1 +5V_CAN1 CAN1: +5V input

2 CAN_LOW CAN data low

3 DGND Digital ground

4 +12V_CAN2 CAN2: +12V input

5 +5V_CAN2 CAN2: +5V input

6 DGND Digital ground

7 CAN_HIGH CAN data high

8 RES Reserved

9 +12V_CAN1 CAN1: +12V input

Image: CAN connector pinout
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14.2. Sync connector

Type of installed connector is Lemo EEG.00.304.CLL (female). Note that there is no distinction between
the two connectors on the DS-CAL test board.

Pin Name Description

1 CLK Clock

2 TRIG Trigger

3 PPS PPS

4 DGND Digital ground

Image: Sync connector pinout

14.3. PPS connector

Type of installed connector is Lemo ECG.1B.304 (female).

Pin Name Description

1 +5V +5V output

2 NC Not connected

3 PPS PPS input

4 GND Ground
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Image: PPS connector pinout

14.4. Power supply connector

Type of installed connector is Lemo EGJ.1B.302.CLA (male).
For the DS-CAL test board an unregulated power supply of 9 to 32 V DC is required.

Pin Name Description

1 + Power supply +

2 - Power supply -

Image: Power connector pinout

14.5. GND connector

For a correct adjustment and calibration check the ground (GND) of the UUT must be connected to the
DS-CAL test board with the supplied banana plug cable.
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15. Appendix B: Glossary and abbreviations

dB
The decibel (dB) is a logarithmic unit that indicates the ratio of a physical quantity (usually power or
intensity) relative to a specified or implied reference level. A ratio in decibels is ten times the logarithm to
base 10 of the ratio of two power quantities.

Dewesoft
Dewesoft refers to the company. DEWESoft™ refers to the software suite for data acquisition, data
processing, data analysis and much more. See www.dewesoft.com.

DMM
Refers to the digital multimeter (for example the Agilent 34410A).

Dynamic Range
Dynamic Range is the ratio of a specified full scale input range to the minimum detectable value (peak
spurious signal). The value for dynamic range is expressed in decibels (dB).

GND
The electrical ground (or earth).

Microsoft®
Microsoft® Corporation is a public multinational corporation headquartered in Redmond, Washington,
USA, that develops, manufactures, licenses, and supports a wide range of products and services
predominantly related to computing through its various product divisions.
DEWESoft™ is a Windows® based application and thus a Windows® operating systemmust be installed
on the measurement PC where DEWESoft™ is installed. See www.microsoft.com.

OS
An operating system (OS) is a set of system software running on a device that manages the system
hardware. This may refer to the operating system of a PC (Windows is required for DEWESoft™) or to the
operating system of the SIRIUS system.

PPS
A pulse per second (PPS) is an electrical signal that has a width of less than one second and a sharply
rising or abruptly falling edge that accurately repeats once per second. PPS signals are output by radio
beacons, frequency standards, other types of precision oscillators and some GPS receivers.

PC
A personal computer. SIRIUS systems are typically connected to a personal computer which runs
DEWESoft™ to fetch the measurement data.

SNR
Signal to Noise Ratio (SNR) is the ratio of the RMS value of the full scale input range to the total RMS
noise measured with the inputs shorted together. The value for SNR is expressed in decibels (dB).
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USB
Universal Serial Bus is a specification to establish communication between devices and a host controller
(usually PCs). SIRIUS systems use a USB connection to connect to a PC.

UUT
“Unit Under Test” refers to the (measurement) device which is intended to be adjusted or calibrated.

Windows®
A PC operating system by Microsoft®. DEWESoft™ works on Windows® 7, Windows® 8 andWindows®
10. Windows® is a registered trademark of Microsoft Corporation in the United States and other
countries.
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16. Warranty information

Notice
The information contained in this document is subject to change without notice.

Note:
Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO
WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED.
DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIEDWARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, incidental, or
consequential damages, whether based on contract, tort, or any other legal theory, in connection with
the furnishing of this document or the use of the information in this document.

The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can
be obtained from your local sales and service office. To find a local dealer for your country, please visit
https://dewesoft.com/support/distributors.

16.1. Calibration
Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every
industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated.
Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one
year, after system delivery.

16.2. Support
Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties
regarding the system. For any support please contact your local distributor first or Dewesoft directly.

Dewesoft d.o.o.
Gabrsko 11a
1420 Trbovlje Slovenia

Europe Tel.: +386 356 25 300
Web: http://www.dewesoft.com
Support Email: Support@dewesoft.com
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00)

Calibration team Email: calibration@dewesoft.com

16.3. Service/repair
The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper
operation in the future. For information regarding service and repairs please contact your local
distributor first or Dewesoft directly on https://dewesoft.com/support/rma-service.
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16.4. Restricted Rights
Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia /
Europe.

16.5. Printing History
Version 2.0.0, Revision 217 Released 2015 Last changed: 23. July 2018 at 16:54.

16.6. Copyright
Copyright © 2015-2019 Dewesoft d.o.o. This document contains information which is protected by
copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written
permission is prohibited, except as allowed under the copyright laws. All trademarks and registered
trademarks are acknowledged to be the property of their owners.

16.7. Trademarks
We take pride in our products and we take care that all key products and technologies are registered as
trademarks all over the world. The Dewesoft name is a registered trademark. Product families (KRYPTON,
SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are registered
trademarks as well. When used as the logo or as part of any graphic material, the registered trademark
sign is used as a part of the logo. When used in text representing the company, product or technology
name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ® sign is not
used in the visual representation of the triangle logo.

DS-CAL V24-1 116/124



DS-CAL
SOFTWARE USER MANUAL

17. Safety instructions

Your safety is our primary concern! Please be safe!

17.1. Safety symbols in the manual

Warning
Calls attention to a procedure, practice, or condition that could cause the body injury or death

Caution
Calls attention to a procedure, practice, or condition that could possibly cause damage to
equipment or permanent loss of data.

17.2. General Safety Instructions

Warning

The following general safety precautions must be observed during all phases of operation, service, and
repair of this product. Failure to comply with these precautions or with specific warnings elsewhere in
this manual violates safety standards of design, manufacture, and intended use of the product. Dewesoft
d.o.o. assumes no liability for the customer’s failure to comply with these requirements.

All accessories shown in this document are available as an option and will not be shipped as standard
parts.

17.2.1. Environmental Considerations
Information about the environmental impact of the product.

17.2.2. Product End-of-Life Handling
Observe the following guidelines when recycling a Dewesoft system:

17.2.3. System and Components Recycling
Production of these components required the extraction and use of natural resources. The substances
contained in the system could be harmful to your health and to the environment if the system is
improperly handled at its end of life! Please recycle this product in an appropriate way to avoid
unnecessary pollution of the environment and to keep natural resources.

This symbol indicates that this system complies with the European Union’s requirements
according to Directive 2002/96/EC on waste electrical and electronic equipment (WEEE).
Please find further information about recycling on the Dewesoft web site www.dewesoft.com

Restriction of Hazardous Substances
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This product has been classified as Monitoring and Control equipment and is outside the scope of the
2002/95/EC RoHS Directive. However, we take care of our environment and the product is lead-free.

17.2.4. General safety and hazard warnings for all Dewesoft systems
Safety of the operator and the unit depend on following these rules.

● Use this system under the terms of the specifications only to avoid any possible danger.
● Read your manual before operating the system.
● Observe local laws when using the instrument.
● DO NOT touch internal wiring!
● DO NOT use higher supply voltage than specified!
● Use only original plugs and cables for harnessing.
● You may not connect higher voltages than rated to any connectors.
● The power cable and connector serve as Power-Breaker. The cable must not exceed 3 meters, the

disconnect function must be possible without tools.
● Maintenance must be executed by qualified staff only.
● During the use of the system, it might be possible to access other parts of a more comprehensive

system. Please read and follow the safety instructions provided in the manuals of all other
components regarding warning and security advice for using the system.

● With this product, only use the power cable delivered or defined for the host country.
● DO NOT connect or disconnect sensors, probes or test leads, as these parts are connected to a

voltage supply unit.
● Ground the equipment: For Safety Class 1 equipment (equipment having a protective earth

terminal), a non-interruptible safety earth ground must be provided from the mains power
source to the product input wiring terminals.

● Please note the characteristics and indicators on the system to avoid fire or electric shocks. Before
connecting the system, please read the corresponding specifications in the product manual
carefully.

● The inputs must not, unless otherwise noted (CATx identification), be connected to the main
circuit of category II, III and IV.

● The power cord separates the system from the power supply. Do not block the power cord, since
it has to be accessible for the users.

● DO NOT use the system if equipment covers or shields are removed.
● If you assume the system is damaged, get it examined by authorized personnel only.
● Adverse environmental conditions are Moisture or high humidity Dust, flammable gases, fumes

or dissolver Thunderstorm or thunderstorm conditions (except assembly PNA) Electrostatic fields,
etc.

● The measurement category can be adjusted depending on module configuration.
● Any other use than described above may damage your system and is attended with dangers like

short-circuiting, fire or electric shocks.
● The whole systemmust not be changed, rebuilt or opened.
● DO NOT operate damaged equipment: Whenever it is possible that the safety protection features

built into this product have been impaired, either through physical damage, excessive moisture,
or any other reason, REMOVE POWER and do not use the product until the safe operation can be
verified by service-trained personnel. If necessary, return the product to Dewesoft sales and
service office for service and repair to ensure that safety features are maintained.

● If you assume a more riskless use is not provided anymore, the system has to be rendered
inoperative and should be protected against inadvertent operation. It is assumed that a more
riskless operation is not possible anymore if the system is damaged obviously or causes strange
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noises. The system does not work anymore. The system has been exposed to long storage in
adverse environments. The system has been exposed to heavy shipment strain.

● Warranty void if damages caused by disregarding this manual. For consequential damages, NO
liability will be assumed!

● Warranty void if damage to property or persons caused by improper use or disregarding the
safety instructions.

● Unauthorized changing or rebuilding the system is prohibited due to safety and permission
reasons (CE).

● Be careful with voltages >25 VAC or >35 VDC! These voltages are already high enough in order to
get a perilous electric shock by touching the wiring.

● The product heats during operation. Make sure there is adequate ventilation. Ventilation slots
must not be covered!

● Only fuses of the specified type and nominal current may be used. The use of patched fuses is
prohibited.

● Prevent using metal bare wires! Risk of short circuit and fire hazard!
● DO NOT use the system before, during or shortly after a thunderstorm (risk of lightning and high

energy over-voltage). An advanced range of application under certain conditions is allowed with
therefore designed products only. For details please refer to the specifications.

● Make sure that your hands, shoes, clothes, the floor, the system or measuring leads, integrated
circuits and so on, are dry.

● DO NOT use the system in rooms with flammable gases, fumes or dust or in adverse
environmental conditions.

● Avoid operation in the immediate vicinity of high magnetic or electromagnetic fields,
transmitting antennas or high-frequency generators, for exact values please refer to enclosed
specifications.

● Use measurement leads or measurement accessories aligned with the specification of the
system only. Fire hazard in case of overload!

● Do not switch on the system after transporting it from a cold into a warm room and vice versa.
The thereby created condensation may damage your system. Acclimatise the system unpowered
to room temperature.

● Do not disassemble the system! There is a high risk of getting a perilous electric shock. Capacitors
still might be charged, even if the system has been removed from the power supply.

● The electrical installations and equipment in industrial facilities must be observed by the security
regulations and insurance institutions.

● The use of the measuring system in schools and other training facilities must be observed by
skilled personnel.

● The measuring systems are not designed for use in humans and animals.
● Please contact a professional if you have doubts about the method of operation, safety or the

connection of the system.
● Please be careful with the product. Shocks, hits and dropping it from already- lower level may

damage your system.
● Please also consider the detailed technical reference manual as well as the security advice of the

connected systems.
● This product has left the factory in safety-related flawlessness and in proper condition. In order to

maintain this condition and guarantee safety use, the user has to consider the security advice
and warnings in this manual.

EN 61326-3-1:2008
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IEC 61326-1 applies to this part of IEC 61326 but is limited to systems and equipment for industrial
applications intended to perform safety functions as defined in IEC 61508 with SIL 1-3.

The electromagnetic environments encompassed by this product family standard are industrial, both
indoor and outdoor, as described for industrial locations in IEC 61000-6-2 or defined in 3.7 of IEC 61326-1.

Equipment and systems intended for use in other electromagnetic environments, for example, in the
process industry or in environments with potentially explosive atmospheres, are excluded from the
scope of this product family standard, IEC 61326-3-1.

Devices and systems according to IEC 61508 or IEC 61511 which are considered as “operationally
well-tried”, are excluded from the scope of IEC 61326-3-1.

Fire-alarm and safety-alarm systems, intended for the protection of buildings, are excluded from the
scope of IEC 61326-3-1.
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18. Documentation version history

Version Date Notes (person who made change) Approved by:

1.0.0 13.05.2014 ☑ Initial revision /

1.0.1 02.07.2014 ☑ Added Manual in Scope of delivery, change length of
GND cable to 2m, changed min. Excel Version to 2010,
remove blank page 23

/

1.1 14.07.2015 ☑ New Logo, Software Version changed to
DSCalibrator5, supported Fluke calibrators mentioned,
corrected PPS connector type gender, Power On
Sequence added, Calibration procedure details added

/

2.0 25.10.2017 ☑ Full document rewrite
☑ Updated document template
☑ Added 3.1. Calibration system equipment support
☑ Updated 3.3. Scope of supply
☑ Added 3.4. Optional accessory packages
☑ Updated 4. Calibration system equipment

configuration
☑ Updated 5. Connecting the calibration system

together
☑ Updated 7. Configuring the DSCalibrator software
☑ Added 7.2. Users
☑ Updated 8. Using the DSCalibrator software
☑ Added 8.5. Special considerations
☑ Added 9. Connecting the UUT
☑ Updated Appendix A: Connectors of the DS-CAL test

board
☑ Updated Appendix B: Glossary and abbreviations

/

V20-1 30.9.2020 New template /

V21-1 05.03.2021 ☑ Updated 7. Configuring the DSCalibrator software
☑ Added 8.6 Custom serial numbers
☑ Added 8.7 Overview report
☑ Added 9.7.7 DSI-CHG-CAL
☑ Updated 3.1.1. Multifunction calibrator support

/

V22-1 04.01.2022 ☑ Updated 9.7: DSI adapters
☑ Fix various spelling mistakes
☑ Fix and remove references to images and pictures

/

V22-2 04.07.2022 ☑ Added IOLITE-CAL-SET
☑ Updated 3.1.1. Multifunction calibrator support
☑ Updated 3.1.2.Digital multimeter support
☑ Added pictures in 3.3.1. DS-CAL-BOX
☑ Updated 3.4.2. KRYPTON-TH-CAL-SET
☑ Replaced image 5.3. DS-CAL test board

/
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☑ Replaced image 9.1. Sirius USB
☑ Updated 9.2. Sirius EtherCAT
☑ Updated 9.3. Sirius Mini
☑ Added chapter 9.3.1. SIRIUSm-3xACC-1xACC+
☑ Added chapter 9.3.2. SIRIUSm-4xACC
☑ Replaced image 9.4.1. Sirius ACC and HS-ACC
☑ Replaced image 9.4.2. Sirius CHG and HS-CHG
☑ Replaced image 9.4.3. Sirius HV and HS-HV
☑ Replaced image 9.4.4. Sirius LV and HS-LV
☑ Replaced image 9.4.6. Sirius STG and STGM
☑ Replaced image 9.4.7. Sirius HD-ACC
☑ Replaced image 9.4.8. Sirius HD-LV
☑ Replaced image 9.4.9. Sirius HD-STGS
☑ Replaced image 9.4.10. Sirius AO
☑ Added chapter 9.5. SIRIUSiwe and chapter 9.7.

MINITAURs
☑ Added image in chapter 9.8. Krypton
☑ Replaced image 9.8.1. Krypton 8xTH, 16xTH
☑ Replaced image 9.8.2. Krypton 4xLV, 8xLV
☑ Updated chapter 9.8.3. Krypton-3 x STG,

Krypton-6xSTG and replaced image.
☑ Replaced image 9.8.4. Krypton RTD
☑ Replaced image 9.8.5. Krypton 4xACC, 8xACC
☑ Added chapter 9.9. Krypton Modular one
☑ Added chapter 9.9.1. Krypton 1 x AO
☑ Added chapter 9.9.2. Krypton 1 x CNT
☑ Added chapter 9.9.3. KRYPTONi-1xTH-HV
☑ Added chapter 9.10 IOLITE R12, R8, LX-R8, R8r
☑ Added chapter 9.19.1 IOLITEir-8xTH and 8xTH-HS
☑ Added chapter 9.10.2 IOLITEr-4xCNT
☑ Added chapter 9.10.3 IOLITEr-8xSTG
☑ Added chapter 9.11 IOLITE multi
☑ Added chapter 9.11.1 IOLITEi-8xRTD
☑ Added chapter 9.11.2 IOLITEi-8xTH and

IOLITEi-8xTH-HS
☑ Added chapter 9.11.3 IOLITE-6xSTG
☑ Replaced image 9.12.1. DSI-ACC, DSI-ACC-0.16Hz,

DSI-ACC-20mA
☑ Replaced image 9.12.2. DSI-V-200
☑ Replaced image 9.12.3. DSI-CHG-50
☑ Updated chapter 9.12.4. DSI-TH-K, DSI-TH-T, DSI-TH-J,

DSI-TH-C
☑ Replaced image 9.12.5. DSI-RTD
☑ Replaced image 9.12.6. DSI-5A
☑ Added Image 9.12.7. DSI-CHG-CAL
☑ Added chapter 9.5.1. SIRIUSiwe-6xSTGM-2xSTGM+
☑ Added chapter 7.5.Environment
☑ Added chapter 7.6. Warmup
☑ Added chapter 7.7. Advanced
☑ Added chapter 7.10. Experimental

(Tadej Blažic)
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V22-3 17.08.2022 ☑ Updated chapter and added image 7. Configuring the
DSCalibrator

☑ Replaced image 7.1. General settings
☑ Updated chapter and replaced image 7.2. Users
☑ Updated chapter 7.4. Database
☑ Replaced image 8. Using the DSCalibrator software
☑ Updated chapter and replaced image 8.1. Adjustment
☑ Updated chapter and replaced Image 8.2. Calibration

check
☑ Added chapter 3.4.6. 100nF-CAP-STD
☑ Added chapter 3.4.7. DS-TOOL-CAL-DOCK
☑ Added chapter 3.4.8. DS-CAL-BOX-DB
☑ Updated chapter 9.10.3. IOLITEr-8xSTGS
☑ Updated chapter 12.2. Support
☑ Replaced image 9.12. DSI adapters

(Tadej Blažic)

/

V22-4 19.10.2022 ☑ Added chapter 3.5. Optional: temperature and
humidity probe

☑ Added chapter 4.2. ROTRONIC HC2A-S temperature
and humidity probe setup

☑ Added chapter 6.3. Download and run Environment
server software

☑ Added chapter 7.5. Environment
☑ Replaced image 9.7. MINITAURs
☑ Updated chapter 10.2. Sync connector
☑ Added Image 9.12.5. DSI-RTD

(Tadej Blažic)

/

V23-1 03.04.2023 ☑ Renamed chapters between chapter 9 and 18.
☑ Added chapter 12.2.4. IOLITEi-8xLA-T2A2f
☑ Updated chapter 6.2. Installation of DSCalibrator

Software (added basic specifications for calibration
PC)

☑ Updated chapter 3.1.1. Multifunction calibrator support
☑ Updated chapter 3.1.2. Digital multimeter support
☑ Updated chapter 9.3. Sirius Mini
☑ Updated chapter 7.3. External devices
☑ Updated chapter 13.4. DSI-TH-K, DSI-TH-T, DSI-TH-J,

DSI-TH-C, DSI-TH-B and DSI-TH-E
☑ Updated chapter 9.2. Sirius EtherCAT
☑ Updated chapter 3.5. Optional temperature and

humidity probe
☑ Added chapter 11.2.4. Kryptoni 1xLV
☑ Updated chapter 12.2.1. IOLITEi-8xRTD and

IOLITEi-8xRTD-T2A4f and added image
☑ Updated chapter 9.4.9. Sirius HD-STGS and

SIRIUS-HD-16xSTGS-L1B10f
☑ Added chapter 9.7. Sirius-HS and Siriusi-HS
☑ Updated chapter 12.1. IOLite R12, R8, LX-R8, R8r
☑ Added chapter 9.8. Siriusi-XHS
☑ Added chapter 8.8. Manual upload of calibration

reports to the Database
(Tadej Blažic)

/
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V23-2 13.11.2023 ☑ Updated chapter 3.1.1. Multifunction calibrator support
☑ Updated chapter 18. Documentation version history
☑ Replaced image in chapter 3. Introduction
☑ Replaced image and updated chapter 13.1. DSI-ACC,

DSI-ACC-0.16Hz, DSI-ACC-20mA
☑ Replaced image in chapter 5.3. DS-CAL test board
☑ Added chapter 12.1.4. IOLITEr-6xSTG
☑ Added image in chapter 9.4.10. Sirius AO
☑ Updated chapter 13.3. DSI-CHG-50, DSI-CHG-100 and

DSI-CHG-DC
(Tadej Blažic)

Uroš Kašca

V24-1 13.03.2024 ☑ Updated chapter 9.4.5. Sirius MULTI
☑ Updated chapter 5.2. Multifunction calibrator and

added images.
☑ Deleted image numbers

(Tadej Blažic)

Uroš Kašca
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